
 
Phase 1 ADE REV 08/2023 

 

 

 

 
 

MENTAL HEALTH MIS 
 

ADMIN DATA ENTRY 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

County of San Diego 
Behavioral Health Services 

 
 
 



 
Phase 1 ADE REV 08/2023 

 

 

 

 
TABLE OF CONTENTS 
Confidentiality……..……………….…………………………………………….. 2 
CCBH Software Basics………………………………………………………….. 3 
CCBH Speak………….……..……………………………………..…………….. 5 
Password Changes…….…………………………………………..……………. 6 
Lock CCBH Session……………………………………………..…………........ 7 
Exiting the Application……………………….…..………………………………. 8 
Clinician’s Homepage Terminology…………………………………………….. 9 
Client Search- CHP………………………………………………………………. 11 
Restore System Defaults………………………………………………………… 15 
Client Face Sheet………………………………………………………………… 16 
Filter Settings…………………………………………………………………….. 17 
Viewing Client Assignments…………………………………………………….. 20 
Core Client Information……….……………………………………………….... 21 
John and Jane Doe Clients……..……………………………………………… 23 
Clients with Identical Sort Names……………………………………………… 24 
Adding New Assessments………………………………………………………. 25 
Demographic Form Overview………………………………………………….. 26 
Clients who are homeless, incarcerated or have no mailing address……… 26 
Electronic Signature Guidelines………………………………………………… 29 
Viewing Assessments……………………………………………………………. 33 
Print Screen……………………………………………………………………….. 34 
Client Assignments…..…………………………………………………………… 36 
Updating the Client Assignment server………………………………………… 39 
Closing the Client Assignment………………………………………………….. 41 
Client Search- External View……………………………………………………. 45 
Display Audit Events……………………………………………………………… 49 
Staff Maintenance Lookup……………………………………………………….. 50 
Client Category Maintenance……………………………………………………. 54 
Admissions Morning Report…….. ……………………………………………… 61 
Client Tracking with Subunit, Name and Phone……………………………….. 65 
Alphabetical Program Roster……………………………………………………. 68 
Caseload Roster by Subunit and Server……………………………………….. 71 
BHS-025 Client Change Requests……………………………………………… 74 
Training Tip Sheet………………………………………………………………… 78 
Optum Support Desk Information .......................................................................... 79 

This handout contains screen shots of confidential and proprietary information 
for view only. It shall not be copied or shared for anything other than its intended 
purpose as a training device for the County of San Diego, Mental Health 
Management Information System. 

 
Admin Data 

Entry 



Admin Data 
Entry 

- 2 - 
Phase 1 ADE REV 08/2023 

 

 

CONFIDENTIALITY 

HIPAA regulations mandate that all client information be treated confidentially. 
 

Access to CCBH is based on your position and your job classification. You will have the 
access you need to complete your job duties. This can include access to clients in your 
Unit/SubUnit or may include full client look up. Remember – with more access comes 
greater responsibility regarding confidentiality! 

 
You are not to share passwords with other staff. The Summary of Policy you signed 
before receiving your access to CCBH included your agreement to this directive. You 
are still responsible if someone with whom you have shared your password violates 
confidentiality! 

 
The MIS unit investigates any suspicions regarding sharing of passwords. 
Consequences are up to, and may include termination. 

 
Do not open any active client charts unless instructed to do so, or if it is required to 
complete your job duties. “Surfing” clients is a blatant breach of confidentiality. 

 
Remember you are personally and legally responsible for maintaining confidentiality. 
Take it seriously. 

 
Do not leave your computer unlocked with client data on the screen for others to access 
or view while you are away from your desk. Lock your CCBH session before leaving 
your computer. 

 
When printing, make sure you are printing to a confidential printer, and pick up your 
paperwork quickly. Leaving printed Protected Health Information (PHI) out is also a 
confidentiality violation. 

 
 
 

Play it safe – keep in mind how you would want your own PHI handled! 
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CCBH SOFTWARE BASICS 

• CCBH IS ACCESSED THROUGH CITRIX (Cerner): 
Go to https://cosdca.cernerworks.com 
(Save this to your favorites or create a shortcut for your desktop) 

• “TAB TO TRAVEL”: Get in the habit of using your “Tab” key. Using the “Tab” 
assures that you are directed to all required fields and that the information you 
input is actually captured by the system. 

 
• RIGHT CLICK: When there is no obvious way to add information into a field, right 

click in the space to view your options. 
 

• FILTERS/RADIO BUTTONS: Check these first and make sure they are on “all” 
when searching the database. 

• MAGNIFYING GLASS/ELLIPSES “BUTTONS”: When you see these at the end 
of a field, it means there is a “Search Screen” that you can pull up to find 
information for that field. You do not have to use them, but they are there if you 
need them. 

• REQUIRED FIELDS are in red or blue: They must be filled-in to save and final 
approve information. 

• OPTIONAL FIELDS are in white: Information may be added, but is not required 
to final approve the Assessment. Keep in mind – just because you have 
completed all the fields required to final approve the form, does not mean 
you have completed a thorough clinical assessment. Documentation 
standards have not changed. 

• CLOSED FIELDS are in gray: Nothing can be added in these fields. 

• CASE SENSITIVE: 

1. Passwords – if you receive an error message for “Invalid Password”, check 
to make sure you are using the appropriate upper and lower case letters 
when typing. After a third attempt with an invalid password, the system will 
lock your session and will require contacting the Optum Support Desk 
(1-800-834-3792) to unlock it. 

2.  Table Searches – when searching within a table, be aware that descriptions 
or IDs are case sensitive. If you do not use the correct upper or upper and 
lower case entry, the search will not take you to the desired table value. 
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• MULTIPLE WAYS TO ACCESS INFORMATION: In CCBH, it is easy to access 
the same information in multiple ways. We have included screenshots and 
directions in this document to guide you through the system. 

• LOCKING YOUR SESSION: For security purposes, you must lock your session 
any time you step away from your computer. This packet explains the various 
ways to lock your session. 

 

Note: Locking your session is best used for short times away from your computer. 
CCBH will log you out after 60 minutes. There is a chance of losing work that has not 
been final approved or saved if CCBH logs you off. 

 
• WHEN YOU GO BACK TO YOUR PROGRAM: You are learning how to enter 

assessments in the “SDC Train CCBH” environment during this training, which 
is for practice purposes only. It is important to enter all of your assessment 
information in the “SDC Live CCBH” environment when you return to your 
program. 

 
• For password resets/menu issues: Call the Optum Support Desk. You may also 

call if you need your “SDC Live CCBH” environment password or menu set up. 
Their contact information is: 

 
Optum Support Desk 

1-800-834-3792 
 
 

Reminder: 
 

Menu access is set according to job title/functions. The menus you have at your 
program may look different than menus shown in the screen shots in this packet. 
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CCBH SPEAK 
 
 

Assessment In CCBH, anything that is not a Client Plan or a Progress Note is 
considered an “Assessment.” So, in CCBH Speak, forms such as the 
Discharge Summary, Outcome Forms, and Demographic Form are 
considered “Assessments” as well as the actual clinical assessment 
forms. 

Assignment Opening/Closing a client to a specific program (Unit/SubUnit/s) and to 
a specific server. 

Clinician’s 
Homepage 

A “page” that provides the Clinical servers at each open assignment to 
view client/s and client information for the identified caseload in one 
screen. This includes client look up, caseload listing, appointments, 
task/s to do, notifications, and other client information present in the 
EHR. 

Collateral 
Server 

Co-Staff providing a service (i.e. co-facilitator). Used when more than 
one staff is providing a service to the same client, on the same date 
and at the same time as server. 

Demographic A client is entered into the EHR by the completion and final approval of 
the demographic form. A client may not be opened to 
assignment/program unless the demographic form is entered, 
completed, and final approved. 

Final Approve Locks the completed 
assessments. 

assessment. Prevents editing/deletion of 

SAI – Single 
Accountable 
Individual 

Primary server identified based on primary unit program set up. This 
staff will be listed as the primary contact for the client in the system of 
care for purposes of coordination of care. 

Scheduler A program within the EHR that allows for scheduling of client service 
events and ongoing appointment/s. This information will populate to 
the Clinician’s Homepage once entered into the EHR through the 
Scheduler menu. 

Service Code Procedure Code. The code data entered into the EHR for the purpose 
of claiming a service activity. 

Server Staff providing a service activity. 

Unit The Physical Location of a program, or legal entity. 

Sub-Unit The specialized set of services offered within a Unit (i.e. population, 
funding sources, etc.). 
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PASSWORD CHANGES 
Citrix (Cerner) Password 
The first Citrix (Cerner) password you ever receive is considered a temporary password. 
For security reasons, you will be prompted to change your password on your first log in. 
To do so after the initial login, click “Change Password” when first logging in to Citrix 
(Cerner). 

 

 
 

Next, follow the prompts to change your 
password. 

 
 
 
 

CCBH Password 
You are prompted by the system to change your CCBH password every 90 days. 
However, if you feel that someone has learned your password, for security reasons you 
should change it immediately. There are two ways to do this: 

External View 
From the External View, go to the “File” tab, 
then “Security” menu and select the “Change 
Password” option. Follow the prompts to 
change your password. 

 
 
 

Clinician’s Homepage 
From the Clinician’s Homepage, go to the 
‘File Tab’. Select the “Security” menu, and 
then select the “Change Password” option. 
Follow the prompts to change your password. 
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LOCK CCBH SESSION 
For security reasons, the expectation is that you will lock your CCBH session any time 
you step away from your computer. There are two ways to do this. 

 
Clinician’s Homepage 

From the Clinician’s Homepage, go to the “File Tab” and select the “Security” drop down 
menu, then select “Lock Session” button. 

 

 
External View 

 

From the External View, go to the “File” tab and select the “Security” drop down menu, then select 
the “Lock” option. 

 
 
 
 
 
 
 

You will be prompted to enter your password to unlock the session. 
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EXITING THE APPLICATION 
 

EXITING CCBH: To make sure you do not accidentally create a “ghost session” 
and lock yourself out of accessing CCBH, you must exit in the following manner: 

 
Clinician’s Homepage 

 
1. Go to the “File Tab” menu in the top left-hand corner of your screen. 
2. Select the “Exit Application” option. 

 

 
 

External View 

• Go to the “File” menu in the top left-hand corner of your screen. 
• Select the “Exit Application” option. 
• Repeat this step for any open external view window. 

 

 
You risk being locked out of CCBH if you do not exit in the manner described 
above! 

 
 



Admin Data 
Entry 

- 9 - 
Phase 1 ADE REV 08/2023 

 

 

 

CLINICIAN’S HOMEPAGE TERMINOLOGY 
Identifying Terms Used on the Clinician’s Homepage 

 
Clinician’s Homepage: 
The Clinician’s Homepage is a real-time tool that provides up-to-the-minute client status 
at a glance. 

 
File Tab: 
The “File Tab” acts as the menu. It can be used to exit 
the application, set preferences, access the external 
view, or see recently opened views. 

 
Tabs: 
The “Tabs” listed below are displayed at the top of the Clinician’s Homepage. 

 
 

• There are four tabs: “File”, “Home”, 
“Client” and “View”. 

 

Note: The “Client” Tab will only be available if the “Client Panel” is set with a client 
name. 

 
Ribbon: 

• The “Ribbon” is an object that is comprised of various buttons. 
 

 
Buttons: 

• The “Buttons” are individual selections that can be clicked on to perform various 
functions. 
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Staff Panel: 
 
 

• The “Staff Panel” will have your 
name. The “Staff Panel” consists 
of three panes. The “Caseload” 
Pane, the “Scheduled Services” 
Pane, and the “Shortcuts” pane. 

 
 
 

 
• Clients will only display under the “Caseload” pane if they have been assigned to 

you. Admin staff are not able to carry a caseload. 
 

 
• The “Scheduled Services” pane displays your scheduled service events for that 

individual day. Admin staff do not provide services. 
 

 
• Any shortcuts set up in the External View will display under the “Shortcuts” pane. 

Shortcuts will not be set up during this training. 
 

Client Panel: 
 

 
 

 
• The “Client Panel” displays information about the client that you selected. The 

“Client Panel” consists of “Client Panes”. You may access the information 
contained in those panes by clicking on each pane. The information contained in 
these areas is pulled from assessments, or forms, in CCBH. 
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CLIENT SEARCH 
Clinician’s Homepage 

• Select the “Client Search” button 
 

 
• The “Client Lookup” window will open 

 

 
There are several different ways to search for a client from this window: 

• If you have the client’s case number, or Social Security number, you can simply 
enter it in the “Case#” or “SSN” field and select “Search”. 

• By “Sort Name”: Enter the client’s sort name in the LAST NAME, FIRST NAME 
format, then select the “Search” button. (The “Sort Name” is the client’s name as 
formatted when first entered into the CCBH system): 
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• If the Sort Name you’ve entered is in the system, it will be displayed in the “Client 
Search Results” area, as in this screen shot which exemplifies a search done for 
fictional client sort name, “PIE, APPLE”: 

 

• If the Sort Name you entered is not in the system, you will receive the following 
stop message: 

 

 
• This does not mean that the client is not in CCBH. Rather, you may not have 

entered the sort name exactly as it was formatted when the client’s information 
was first entered into the CCBH system. For this reason, you should search by 
other criteria such as: 

 

Note: Before beginning another type of search, select the “Clear” button to 
reset the search criteria. 

 

• In client search, enter LAST NAME, FIRST NAME, date of birth (check spelling 
and in ALL CAPS). 

• If client is found with that name, double check SSN. 
• Search by SSN. 
• Search by Alias. 

• If match found, open the Demographic form on client and double check DOB, 
address, SSN. 
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• Check 3rd Party information to see if client has the same Medi-Cal (BIC, CIN) 
number. 
• If it is unclear which is the first name or the last name, enter the other 

position of names in Alias – e.g., Bubble Gum entered into CCI as GUM, 
BUBBLE may be entered into Alias as BUBBLE, GUM. 

 

 Note: When searching use all capital letters, these fields are case sensitive. 

• You can now search by one or more of the other criteria fields (Last, First, 
DOB, Alias Last, First, Sex, Case Number). Select the “Search” button. 

 
 

 

 Note: If you search by data that is common in the system (such as conducting 
a search only by a common first name) you will receive the following warning 
screen. This allows you the option to either continue with or cancel the search. 
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Additional Client Search Feature 

• The “Thru” field, in conjunction with the “DOB” field allows you to search for 
clients within a particular date range. For example, if the DOB is 
approximately 3/10/1964 and you can enter 3/08/1964 in the “DOB” field and 
3/12/1964 in the “Thru” field, all clients in the system who have that dates of 
birth in that date range will be displayed in the “Client Search Results” 
window. 

 
 

Note: If the exact DOB is known ~ enter it in the ‘DOB’ and ‘Thru’ fields to find 
clients born only on that date. 
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RESTORE SYSTEM DEFAULTS 
 

If the layout becomes distorted, or the panes have disappeared, select “Restore Panel 
Layout” (under the Layout and Filters button on the Home tab). This will restore the 
layout to what it was when you first logged in. 

 

 
Select “Restore Panel Filters” (under the Layout and Filters button on the Home tab) to 
bring all the Filters back to their default settings, if desired. 

 
 

 
 

NOTES 
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CLIENT FACE SHEET 
 

The Client Face Sheet will allow users to view any entered information from the client’s 
most recent final approved Safety Alert, Demographic Form, and Diagnosis Form. The 
Client Face Sheet displays the Primary Unit, SubUnit and SAI for the client. If the client 
information has not been entered on one of these forms, the corresponding information 
fields on the Face Sheet will be blank. 

• After accessing a client, the Client Face Sheet can be viewed by clicking the “Face 
Sheet” pane in the client panel. 

 

 
• The Client’s Face Sheet cannot be edited from this view. To print click on the drop 

down arrow  at the top right, and click “Print Face Sheet”. 
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FILTER SETTINGS 
 

Modifying filter settings to display historical assessments 
 

Each user may personalize the way filters display information in his or her Clinician’s 
Homepage. Any time you do not see the desired information, the first step is to check 
the filters to assure the correct parameters are selected for your search. 

 
A. On the “Client Panel”, click on the “Assessments” pane. The “Assessments” pane 

will open an expanded window. 
B. Click the drop down arrow  on the “Assessments” bar. 
C. The “New Assessment”, “Filters”, and “Refresh Pane Content” window will display. 

Click on the check mark  or on the word “Filters”. 
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D. The “Filters” window will display. There are three areas where you can make 
changes. 

E. Date: If a desired assessment is before the date listed, and is not 
displaying on the “Assessments” tab; you must adjust the date 
manually. 

F. From the drop down menu, you may choose A: “Include Final 
Approved and non-Final Approved Assessments”, F: “Include Final 
Approved Assessments only” or N-Include non-Final Approved 
Assessments only”. 

G. You may filter by “Assessments Signed By”, “Assessment Type”, 
and “Category of Treatment”. 

H. You may also place a checkmark by the “Include Voided 
Assessments”, “Include Preferred Assessments only”, or the 
“Include the latest Assessment of each type only” choices given. 
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Filters in Clinician’s Homepage: 
 

Several panes located within the Client Panel contain “Filters”. Below are some 
examples: 

 
Assignments Pane Filters: updates the Assignments Pane to display Opened and 
Closed Assignments. 

 

 
Services Pane Filter(s): updates the display of the Services Pane. The date field 
filters for services on or after the date entered. Check boxes further filter that data, for 
particular service types or services by specified staff, for example. 
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VIEWING CLIENT ASSIGNMENTS 
Clinician’s Homepage 

 
Client “Assignments” refer to where the client has received, or is currently receiving, 
services. In the “Clinician’s Homepage” you can view the Opening/Closing dates when a 
client was assigned to a specific program (Unit/SubUnit/s) and to a specific server. 

 
1. In the “Client Panel” click on the “Assignments” pane. 
2. It displays all the assignments attached to the client. 

 

 
 

NOTES 
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CORE CLIENT INFORMATION 
 

Note: Before entering a new client, always search to ensure that the client is not 
already in the system. Refer to the “Client Search” tip sheet on the previous 
pages. 

If you are sure that the client is not already in the system, click on the “Add Client” 
button in the “Client Lookup” window. 

 

After you click on “Add Client”, the “Core Client Information Maintenance Panel” window 
will display. 
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Just start typing – DO NOT click into the Sort Name field. Doing so could add a space at 
the beginning of the field. If this happens, the client will not be found if searched for by 
Sort Name. Enter as much client information as you have into the CCI. 

 
In the “Sort Name” field, enter the client’s name. Do not forget the comma and the 
space in between the last and first names. Verify that the spelling and format are 
correct, as this is how other staff members will be searching for the client’s name in the 
future. 

-or- 
 

Note: If a client’s name, date of birth, or social security is incorrect, fill out form 
BHS-025 and contact Medical Records. 

 
• Do not enter a suffix (i.e. Jr., Sr., II, III) 
• Do not enter punctuation, apostrophe (‘) or hyphen (-) 
• Do not enter spaces (i.e. if the client has 2 last names, run them together) 
• When names are hyphenated or have another prefix such as Super-Human, 

it is important to enter the names into the Alias section to help facilitate future 
searches – e.g., Awesome Super-Human should be entered as an alias as 
HUMAN, AWESOME and also as SUPER, AWESOME. 

• Do not use non-English letters (i.e. ñ) 
• Press the Tab key and the client’s Sort Name will populate the Last Name, 

First and Middle Name Fields 
 

Enter the client’s DOB in the following format: MM/DD/YYYY.  
Note: For the remaining optional fields, enter the client’s 

information. The information will populate to the Demographics form. 
 

Click on the “Save and Close” button. 
 
 
 

When asked about assigning a case number to this 
client, Always select “Yes.” 

 

The client’s name is now in the system as a new client. 
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Entering John and Jane Doe Clients: 
 

When an unidentified client presents, use the following guidelines for entering the client 
into CCBH. Note: Once the legal name is known, submit a BHS-025 with supporting 
documentation to medical records. The final page in this packet contains that 
information. 

 
For all programs (except ESU), enter: 

 
 

-or- 

 
 

MM/DD/YY = date of client admission/contact. The date will default into the “Middle 
Name” field. Delete the numbers in the “Middle Name” field before saving the 
record. 

If the client’s date of birth is unknown and cannot be estimated, enter 01/01/1901. 
 

For the ESU, enter: 
 

 
ESU1 = The first John/Jane DOE client of the day. 
ESU2 = The second John/Jane DOE client of the day. 

 
MM/DD/YY = date of client admission/contact. The date will default into the “Middle 
Name” field. Delete the numbers in the “Middle Name” field before saving the 
record. 

If the client’s date of birth is unknown and cannot be estimated, enter 01/01/1901. 

For John Doe’s, enter “M” as the sex, and for Jane Doe’s, enter “F” as the sex. 
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Entering Clients with Identical Sort Names: 
 

 
If the above message appears when entering the Core Client Information (CCI), double 
check to ensure that the client is not already in the system. If the existing record is for a 
different client, adjust the client’s sort name. This is accomplished by entering the new 
client’s date of birth to the end of the client’s name. Example: 

 
 

 
The DOB will default into the “Middle Name” field. Delete the numbers in the “Middle 
Name” field, and enter the appropriate middle name/initial. However, do not change the 
“Sort Name” field. See the example below: 

 

 
 

Special considerations: 
• When available, the client’s middle name should always be entered. 
• In the case of identical first and last names, the middle name may be all that 

is needed to differentiate among clients. If that is not enough, then the DOB is 
added to the end of the sort name field. 

• When a date is added to the end of the sort name field, it appears in the 
middle name field. Make sure to remove it before moving forward. 
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ADDING NEW ASSESSMENTS 
 

From the “Client” tab, click the words “New Assessment”, and click on the assessment 
you wish to add. 

 
 

 
Enter the date that the client gave this information to the staff. This is called the 
“Effective Date” on the paper form, and it is located in the top left hand corner. Be 
mindful when entering this date, as it cannot be changed. After you’ve entered the 
“Effective Date,” select “Save.” 
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DEMOGRAPHICS FORM OVERVIEW 

• For any address: 
By entering the “Zip Code” and then pressing the tab key on the keyboard, the 
city/state/county will populate. 

 
 

 
• For Clients who are Homeless, Incarcerated, or Have No Reported Mailing 

Address: 
The physical address for a client who is homeless is entered with the word “homeless”, 
and a zip code. 

 

Note: If you have additional information (i.e.- frequents Balboa Park), type it after 
the word “homeless” in the Physical Address field. 

 

 
In the zip code field, enter the zip code of the area where the client sleeps or frequents 
(if known). 

 
If you do not know the zip code where the client frequents, enter the zip code of your 
program. 

 
For individuals who are incarcerated, the jail’s address is entered as the physical 
address. 

 
For individuals who have no reporting address, enter the address of the client’s 
primary subunit in both the physical and mailing address fields. 

 
• Phone 

If the paper demographic form does not include a home phone number, type “NONE”. 
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• Religion 
If the paper demographic form lists a religion that is not included in the table, use your 
judgment to choose the most appropriate selection. 
For example: 13 Atheist 

12 No Religious Preference 
98 Other 
08 Other Christian 
99 Unknown 

 

• Mother’s First Name 
If the client’s “Mother’s First Name” is blank on the paper demographic form, type in 
“Unknown” instead of “None”. 

 
 

 
• Alias/Contacts 

When adding/editing an Alias or Contact, right click into the box to view your menu 
options. 

 

 
 

 
 

 
 



Admin Data 
Entry 

- 28 - 
Phase 1 ADE REV 08/2023 

 

 

Help Text 
Help Text is available for staff throughout the assessment. Help texts can be accessed 
by clicking on the question mark icon. For example, if you click on the “Preferred 
Language (Caretaker)” help text icon, the following help text appears: 
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ELECTRONIC SIGNATURE GUIDELINES 
 

Signature Instructions on the Demographic Form. 

The Demographic Form allows the form to be signed and final approved in one action. 
 

1. Select “Final Approve,” located at the top of the window. 
 

 
2. Enter your CCBH password when prompted. 

 

 
Signature Instructions on the Diagnosis Form: 

 
There are three credential restricted 
signature lines located in the “Validations” 
pane of the Diagnosis Form. 

 
Support staff entering information on 
behalf of others, from a hard copy, will 
address the signatures as they are listed 
on the hard copy. 

 
 

 
 

 
 



Admin Data 
Entry 

- 30 - 
Phase 1 ADE REV 08/2023 

 

 

Sequence 1: 
If the hard copy is signed by a staff that required a co-signature: 

1. Sequence 1 (Staff Requiring a Co-Signature) left click and select “Document 
Signature on Hard Copy.” 

 

 
2. Enter the staff’s CCBH ID number. Make sure to adjust the date to match the 

hard copy. Select “OK.” 
 

 
3. Enter your CCBH password. 
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If the hard copy is not signed by a staff that required a co-signature: 
1. Sequence 1 (Staff Requiring a Co-Signature) left click and select “Delete.” 

 

Sequence 2: 
1. Sequence 2 (Staff Comp/Accept Assessment) left click and select “Document 

Signature on Hard Copy.” 
 

 
2. Enter the staff’s CCBH ID number. Make sure to adjust the date to match the 

hard copy. Select “OK.” 
 

3. Enter your CCBH password. 
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Sequence 3: 
1. Sequence 3 (Staff Entering Information) left click and select “Electronically Sign.” 

 

 
2. Enter your CCBH password. 

 

3. Select “Final Approve” located at the top of the window. 
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Saved forms: 

VIEWING ASSESSMENTS 

• Are “saved” but not final approved. 
• Can be edited or deleted by anyone who has access to that client’s forms. 
• Will hold up the work flow as they prevent adding another form in which any fields 

are shared. 
Lock it down by Final Approving to protect your work!! 

 

How to open a saved assessment: 
• Select a client and open the “Client Panel”. Next, click the “Assessments” pane. 
• A list of assessments will display. The assessment that is not final approved will 

not have a check under the Final Approved status (F/A). 
• Double click the assessment. The selected assessment will open for data entry 

and completion. 
 

VIEWING FINAL APPROVED ASSESSMENTS 
• Select a client and open the “Client Panel”. 
• Next, click the “Assessments” pane. 
• A list of assessments will display. The assessments that are final approved will 

have a check under the Final approved status (F/A). 
• Double click the assessment. The selected assessment will open for review. 
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PRINT TO SCREEN 

Note: Before printing a hard copy, always print to screen first to verify whether 
printing is truly necessary. 

 
• Click the “Print” button. 

 
 

 

• Click on the down arrow to the right of the “Printer” field, click “Print Preview”, 
and click the “Print” button. 

 
 

 
 
 

It will take a few moments to process the command. Wait 
until the following message disappears. 
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A copy displays on the screen. Pay attention to the total number of pages before 
deciding to print a physical copy. 

 
 

Icons 
 

You will find icons across the top of the print screen which will allow navigation through 
the copy. 

 

 
 Prints a physical copy. 

 

 Emails a copy. DO NOT use this feature, as it is a breach in confidentiality. 

 Displays the default size of the copy. 

 Shrinks the copy down to 25% of the default size. 
 

Zooms in by 50% each time the icon is clicked. 

 Zooms out by 25% each time the icon is clicked. 

Navigates directly to the first page. 
 

 Navigates back one page. 
 

 Navigates forward one page. 

 Navigates directly to the last page. 

 Displays keyboard commands for navigating through the copy. 
 

 Displays the details of the software product. 
 

 Closes out of "Print to Screen” and returns to the original view. 
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CLIENT ASSIGNMENTS 
 

To get to the Client Assignment window: 
1. Click on the “File Tab” 
2. Click “Menu” 
3. Click “Client Assignments” 
4. Click “Client Assignments Maintenance” 

 

There are two ways to access the Client Assignment Window from the external view. 
 

1. Click on the “Home Tab”, then “Menu”, click on “Client Assignments”, then select 
“Client Assignments Maintenance.” 

 
2. From the short cut menu on the left, if you have created one, click once on the 

“Client Assignments icon.” 
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The “Client Assignments Maintenance” window will display. 
• In the blue field, enter the Client’s case number or the Client’s sort name (Last, 

First) in the “Client” and press the “Tab” key. 
• Click the “Add” button to begin the opening of the assignment process. 

 

 
Note: If you get an error message that reads, “Assignments may not be entered for 
pre-registered clients” this indicates that on the demographic form, the “Admit” radio 
button was not checked. This requires updating the demographic form and selecting 
the “Admit” radio button. 

• From the “Assignment Form Entry” window, enter the effective date of the Client 
Assignment opening and the CCBH ID number of the staff completing the form. 

• From the Form Type field, click on the arrow and from the drop down menu, 
select, “A-Admit” and click, “Ok”. 
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• A new Client Assignment window will appear: 
 

 
Treatment Session: Leave this field blank. 
Date Opened: This date pre-populates from the previous window. 
Unit: Enter your program Unit in this field; hit the “Tab” key. 
Sub Unit: Enter your programs SubUnit number in this field; hit the “Tab key. 
Treatment Team: Leave this field blank. 
Current Server: Enter the Server’s CCBH ID number. 
Note: The date from the “Date opened” field will auto populate from the previous 
window. If it’s not correct, select cancel and return to previous step. 

 
• The final step is to click the “Save” button. 
• After you have clicked “Save”, you are taken back to the “Client Assignment 

Maintenance” window. 
• The Assignment Status for this client is now “Admitted.” 
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• The highlighted entry below represents the completed assignment opening 
effective 01/01/2023. 

 

How to Update a Server 
• Open the “Client Assignments Maintenance” window. 
• In the “Client” field, enter the Client’s case number or the Client’s name (Last, 

First) and press the “Tab” key on your keyboard. 
• Select the assignment you want to update by clicking on the Unit name until it’s 

highlighted. 
• Click the “Edit” Button. 
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• The “Assignment Form Entry” window will display. 
• Enter the effective date of the Client Assignment update and the CCBH ID 

number of the staff completing the form. 
• In the “Form Type” field, click on the drop down arrow, select, “U-Update” and 

click, “OK”. 

 
 

• A new Client Assignment window will appear. The following fields will auto 
populate from the previous window: Date Opened, Unit & Sub-Unit, and Current 
Server. 

• Delete the Current Server and Enter the New Server’s CCBH ID number and 
press the “Tab” key (the start date to the right will update). 

• The last step is to click, “Save.” 
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• After you have clicked “Save”, you are taken back to “Client Assignment 
Maintenance” window. 

 

 
• The highlighted entry above represents the completed Server update and reflects 

the new Server: TRAINEE, STAFF. 
 

How to Close a Client Assignment 
• From “Client Assignments Maintenance” window; enter the Client’s case number 

or the Client’s name (Last, First) and press the “Tab” key. 
• From the display window, select the assignment you want to close by clicking on 

the Unit name until it’s highlighted. 
• Click the “Edit” button to begin the opening of the assignment process. 
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• From the “Assignment Form Entry” window, enter the effective date of the Client 
Assignment closing and the CCBH ID number of the staff completing the form. 

• From the Form Type field, click on the arrow and select, “C-Close” and click, 
“OK”. 

 

 
• A new Client Assignment window will appear. The following fields will auto 

populate from the previous window: Date Opened Unit & Sub-Unit, Current 
Server and Date Closed. 

• Closing Reason: Click on the magnifying glass to show the closing reasons 
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• The “Assignment Close Dispositions Lookup” window will display. 
• Select the applicable code and press “OK”. 

 

 
• The last step is to click, “Save.” 

 

 
• After you have clicked “Save”, you are taken back to “Client Assignment 

Maintenance” window. 
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• The Assignment Status for this client is now: “Closed-Adm.” 
• The highlighted entry below represents the completed assignment closing 

effective 07/17/2023. 
• Ensure to select the radio button for “Closed Assignments” or “All 

Assignments” to view. 
 

 
Adding MD or RN Unit/Sub-Unit (If Applicable): 

 
NOTE: Billing cannot be entered for an MD or RN subunit, as is not setup for billing 
purposes. The purpose of adding the MD and RN subunit, is so they are able to see the 
client on their caseload in their Clinician’s and Doctor’s Homepage. 

 
NOTES 
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CLIENT SEARCH 
External View 

Client search: 
 

• Click on the magnifying glass icon. 
 

 
• The “Clients Lookup” window will display. 

 
 
 
 

 
 
 
 
 
 
 
 

MULTIPLE WAYS TO SEARCH 
 

Searching by Sort Name: 
 

1. Before you begin your search, select the “All” radio button. 
2. To begin the search function, place your cursor in one of the boxes under the 

“Sort Name” column. 
3. You will see a dotted outline that appears around the box that you selected. 
4. Start typing the last name of the client that you are searching for in capital letters. 

The “Sort Name” box appears. 
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5. Type LASTNAME comma space FIRSTNAME. 
6. Click “OK”. 
7. After you locate your client click “OK” once more. 

Searching by Case Number 
 

1. Select the “All” radio button. 
2. To begin the search function, place your cursor in one of the boxes under the 

“Case Number” column. 
3. You will see a dotted outline that appears around the box that you selected. 
4. Start typing the “Case Number” of the client you are searching for. The “Case 

Number” box appears. 
 

5. Click “OK”. 
6. After you locate your client click “OK” once more. 

Searching by Date Of Birth 
 

1. Select the “All” radio button. 
2. To begin the search function, place your cursor in one of the boxes under the 

“DOB” column. 
3. You will see a dotted outline that appears around the box that you selected. 
4. Start typing the “DOB” of the client you are searching for. The “DOB” box 

appears. 

 
5. Click “OK.” 
6. After you locate your client click “OK” once more. 

 
 



Admin Data 
Entry 

- 47 - 
Phase 1 ADE REV 08/2023 

 

 

Searching by Alias 

1. On the “Clients Lookup” window, click on the “Alias Lookup” button. 
 
 

2. The “Client Aliases Lookup” window will appear. 
 

 
Searching by Last Name: 

 
1. To begin the search function, place your cursor in one of the boxes under the last 

name column. 
2. You will see a dotted outline that appears around the box that you selected. 
3. Either click “Find”, or just start typing the last name of the client that you are 

searching for in capital letters. The “Last Name” box appears. 
 

4. Click “OK”. 
5. After you locate your client click “OK” once more. 
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Searching by First Name: 
 

1. To begin the search function, place your cursor in one of the boxes under the 
“First Name” column. 

2. You will see a dotted outline that appears around the box that you selected. 
3. Start typing the last name of the client that you are searching for in capital letters. 

The “Last Name” box appears. 
 

4. Click “OK”. 
5. After you locate your client click “OK” once more. 

 
If the client is not located after a thorough search, users may add that client to the MH 
MIS system (see the “Core Client Information” tip sheet). 

 
Search reminders and things to keep in mind: 

 
• Always select the “All” radio button when searching. 
• Use CAPS when searching by name. 
• Remember if you are searching by client’s name, enter it in the following way: 

LASTNAME comma space FIRSTNAME. (e.g. CAR, BLUE). Except Alias, which 
you search by LASTNAME and FIRSTNAME separately. 

• You must complete a thorough search before adding a new client. Search by 
Client Name, Social Security Number (SSN), Case Number, Date of Birth (DOB) 
and ALIAS. 
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DISPLAY AUDIT EVENTS 
To see when an assessment was added, edited, final approved, viewed, or printed, 
utilize Display Audit Events. Display Audit Events will display who touched the 
assessment, when, and what action was completed. 

1. Right click on the assessment details you wish to view. Select “Display Audit 
Events.” 

 

2. Each column in the window that appears can be sorted by clicking on the column 
header. The window will display a line for each separate action a staff takes (add, 
edit, sign, final approve, display, and print). 

 

 
 

3. Select “Close Panel” to return to the 
Assessments Pane. 
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STAFF MAINTENANCE LOOKUP 
How to Lookup a Staff for Contact Information 

• From the CLINICIAN’S HOMEPAGE, click the “File Tab”, click “Menu”, click 
“System Tools”, and click “Staff Maintenance”. 

 

 
 
 
 
 
 
 
 

- 50 - 
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• From the EXTERNAL VIEW, click on the “Home Tab”, then “Menu”, from the drop down 
menu select “System Tools”, then “Staff Maintenance”. 

 

“Staff Maintenance” Menu: 
 

When the “Staff Maintenance” Menu launches, your staff ID and name will be 
highlighted in blue as a default. Your current contact information on file will be listed 
under the “Main”. 

 

 
 

- 51 - 
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To begin your search: 
 

• Press the “Find” button at the bottom of the window. 
• The “Search: Sort Name” box will launch. 

NOTE: You may search by “ID” or “Sort Name” by clicking under the desired column 
before pressing “Find”. A red dotted box will display under the field you 
are searching. 

 

 
Search Window: 

 
 
 

• Type in the desired 
name of the staff you 
wish to find. 

NOTE: The format must be last name, comma, then SPACE, and first name. For 
example, “CLINICAL, STAFF” would be the proper format. 
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• The contact information of the staff for which you have entered will display under 
“Main”. 

 
• The “Internal Phone” number as well as the “Email Address” will be listed when it 

is available. 
 
 
 

NOTES 
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Client Categories Maintenance 
 

Entering Client Categories Maintenance: 
Once the program has confirmed that a client belongs in one of the client categories in 
CCBH, programs must make the appropriate designation. There is a brief glossary 
attached about each category. 

This is done through the “Client Categories Maintenance” screen. 

Once the client’s name has been selected from the CHP (and the Client Panel is 
open), follow these steps: 

 
 

1. From the Clinician’s Homepage (CHP), go to the “File Tab”, click on “Menu”, 
then click “ATP”, then select “Client Categories Maintenance”. 
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2. The “Client Categories Maintenance” window will launch, with the name of client 

you selected on your CHP pre-populated in the “Client” field. (If you did not 
select a client prior to this step, simply enter the client number in this field and 
select “Tab” to populate the client’s name). 

 
 

 
3. Click on the “Magnifying Glass”. This will open the “Client Categories Lookup” 

window. Select the appropriate option for your client. 
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4. Your selection will now populate in the “Category” field. Next click on the 
“Effective Date” calendar icon to add the date it was determined the client was 
eligible. Once the date has been entered, click “Save” to save your selection. 

 

 

5. Your saved selection will now appear in the middle container. You can then click 
on the “Exit” button at the bottom of the screen to close the window. 
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6. When the program has confirmed that the client is no longer eligible, the program 
must return to the “Client Categories Maintenance” screen to enter an end date. It 
is the same steps as 1-2, except the program is entering information into the 
“End Date” instead of the “Start Date” field. Once the end date is entered, make 
sure to click “Save”. This saves the updated information in the middle container. 

 
 

 

7. Then, click on the “Exit” button at the bottom of the screen to close the window. 
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Client Category Maintenance Glossary 
 

AB109 
A funding source for clients that are low risk offenders released from State custody to 
the County of San Diego for supervision and services. Alcohol, Drug & Mental Health 
services at various programs are provided to those that qualify for them. The goal is to 
provide supportive and rehabilitative services to these individuals to help them meet 
their needs and stay out of the justice system. 

“AB109 Funded” are those programs that have a contract with the County to provide 
services to this population, and the “AB109 Non-Funded” are programs that an AB109 
designated client may go to if the funded programs are full and impacted, but the 
program is not receiving contract funding for the services. The “Funded” programs are: 
CRF HEARTLAND CENTER, CRF MARIA SARDINAS WELLNESS & RECOVERY, 
EXODUS CENTRAL, and TELECARE PROPS. 

 
Assertive Community Treatment (ACT) 
ACT Services are provided in a multi-disciplinary team-based model of service that uses 
a comprehensive team approach and provides treatment 24 hours a day, 7 days a 
week, 365-days a year. The services are targeted for homeless persons with a severe 
mental illness who may have a co-occurring disorder, are unconnected to outpatient 
services, may be referred by the justice system, have multiple major areas of 
impairment, have more than one long term care episode, and multiple ER and acute 
care hospitalizations and justice related episodes. 

 
The ACT program provides integrated mental health and medication services, 
rehabilitation and recovery services, intensive case management and have a staff-to- 
client ratio of approximately 1:10. Clients are typically provided services in person at a 
minimum of four (4) times per week to meet with the client’s clinical needs and meet 
ACT fidelity rating. Services may be provided on a much more frequent basis, 
depending on client need. 

 
ACT Strength-Based Case Management (SBCM) 
Strengths-Based Case Management services are delivered through BHS contracted 
service. Programs assist clients with severe mental illness who may have a co-occurring 
disorder to access needed mental health, medical, educational, social, prevocational, 
vocational, housing supports and rehabilitative or other community services. The 
service activities may include, but are not limited to case management, care 
coordination, referral and linkage to needed services; monitoring services delivery to 
ensure beneficiary access to services and the services delivery system, monitoring of 
the client’s progress, and plan development 
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AOT Court Ordered 
Assisted Outpatient Treatment, also known as Laura’s Law, is a process by which the 
court, after a thorough investigation, orders an individual into an appropriate level of 
treatment. Individuals who are ordered into treatment are required to meet 9 criteria 
under Laura’s Law with the primary deciding clinical factor being client is “substantially 
deteriorating.” As part of the petition process, the licensed mental health clinician must 
prove to the court via an AOT evaluation that this level of treatment is the least 
restrictive level of treatment and, if not ordered, may result in the decompensation of the 
individual. The treatment offered in this category is the same level of treatment as an 
Assertive Community Treatment model. 

 
AOT Voluntary 
Similar to AOT Court Ordered, the individual is required to meet nine criteria under 
Laura’s law with the primary deciding clinical factor being client is “substantially 
deteriorating.” In this category, however, the client has not been court ordered into 
treatment. Though the client has met the definition for Laura’s Law and a licensed 
mental health clinician has conducted an AOT evaluation, the client has willingly agreed 
to participate in the AOT program and avoid the court process. The treatment offered in 
this category is the same level of treatment, an Assertive Community Treatment model, 
offered to individuals in the AOT Court Ordered category. 

 
Augmented Services Programs (ASP) 
Strive to enhance and improve client functioning through augmentation of basic Board 
and Care (B & C) services to specific individuals living in specific B & C facilities with 
which the County has an ASP contract. Emphasis is on developing client strengths, 
symptom management, and client self-sufficiency. Priority for ASP services is given to 
those people in most need of additional services. Any BHS funded case management 
services program may refer to ASPs. 

 
Emergency/Transitional Shelter Bed 
The goal of ETSB is to provide short term housing assistance to individuals connected 
to the respective clinic while stable income is sought. Emphasis is on securing stable 
income, symptom management, and client self-sufficiency. Priority for ETSB services is 
given to those people with a pending SSI claim. 

 
BHS Regional Clinics (North Central, East County, North Inland, and North Coastal) are 
the designated locations for referrals to the Emergency & Transitional Shelter Bed 
(ETSB), through the respective clinic Homeless Outreach Worker (HOW). 

 
Katie A. 
A shorthand way of referring to the settlement agreement for a class action lawsuit 
brought against the County of Los Angeles and the State of California. The result is that 



Admin Data 
Entry 

- 60 - 
Phase 1 ADE REV 01/2023 

 

 

specific collaboration between County Behavioral Health Systems and Children’s 
Welfare Services is mandated so that certain children in both systems of care are 
guaranteed to receive intensive services to address their needs of safety, permanency 
and well-being. It is for Children’s programs only. In San Diego County, we refer to Katie 
A. as Pathways to Well-Being or the acronym PWB, so you may hear this language in 
your program. The class action lawsuit settlement defined members of the class and 
members of the subclass. These are legal terms that spell out what criteria need to be 
met in order to receive the specialty mental health services that the settlement defines. 

A clinician in your program will give you a form that says if the client meets criteria for 
Katie A Class or Subclass. This is the information you will put into Client Categories 
Maintenance. There have been several trainings on PWB, so if you are unfamiliar with 
this and the services provided (and you work in the Children’s System of Care) talk to 
your program manager for more specific information. 

 
Parolee 
On a regular basis, individuals are discharged on parole from California State penal 
institutions. In many instances, these persons are in need of mental health services. 
Parolees who fall under the Forensic Conditional Release Program (CONREP) will be 
provided services in accordance with the current contract between the California 
Department of Health Care Services and the County of San Diego. Parolees who are 
Medi-Cal beneficiaries and who meet specialty mental health medical necessity 
requirements, as specified in WIC 14184.402(A), 14059.5 and Section 1396D(5) of Title 
42 of the United States Code, will be provided appropriate Medi-Cal covered mental 
health services. Due to the passage of SB 389, MHSA funds may be used to provide 
services to persons who meet existing eligibility criteria for MHSA-funded programs and 
who are participating in a pre-sentencing or post-sentencing diversion program, to 
provide services to persons who are on parole, probation, PRCS, or mandatory 
supervision. 

 

NOTES 
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REPORTS 

ADMISSIONS MORNING REPORT 
 

This report provides a list of clients who have had services from the EPU, ESU, 
SDCPH, FFS hospital, or the jail inpatient Units. NOTE: This is a work around until the 
enhancement is completed. The current report will print a listing of all the clients by 
Unit/SubUnit who had an assignment opened at these facilities for the date range 
entered. Therefore only print those pages pertinent to your Unit/SubUnit. Please black 
out or detach and shred other Unit/SubUnit information that prints on the report. 

• To access the template from the Clinician’s Homepage, click on the File Tab  
click “Client Assignments”  click “Client Assignments Reports”  and click 
“Client Roster Report”. 

 

• To access the template from the external view, click on the “Home Tab”, select “Menu”, then 
click on “Client Assignments”, “Client Assignments Reports”, then “Client Roster Report”. 
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• Select “Load” on the “Client Roster Report” window. 
 

 
• Highlight “Admissions Morning Report” from the template list and select “Load”. 
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• Selections 1 tab is preset. Do NOT enter Unit and SubUnit. 
 

 
• On Selection 2 tab, enter the one day date (previous day) in the “Assignments 

with Date Opened from and thru” field. For programs closed on weekends and 
running the report on Monday morning, select the dates to cover the weekend 
dates. 
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• The other tabs are pre set. 
• Select “Print” to print the report. 
• The “Print Destination” screen will appear. 
• Select “Default (Printer/Screen)” to preview the report prior to printing. Click 

“OK”. 

 
 

NOTES 
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CLIENT TRACKING WITH SUB-UNIT, NAME AND PHONE 
 

This report lists a client’s home phone number, DOB, SSN, Unit, SubUnit, SubUnit 
Description, SubUnit phone number, server number, server name, assignment open 
dates, assignment closed dates, last service date, primary SubUnit, and count. 
• To access the template from the external view, click on the “File Tab”, select “Menu”, 

then click on “Client Assignments”, “Client Assignments Reports”, then “Client Roster 
Report”. 

 

 
 

• Select “Load” on the “Client Roster Report” window. 
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• Highlight “Client Tracking With SubUnit Name and Phone” from the template list 
and select “Load”. You may need to use the scroll bar on the right to locate it. 

 

 
• On Selections 1 tab, enter the client’s CCBH number or name (LAST, FIRST), in 

the “Clients” field. 
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• Select “Print” to print the report. 
• The “Print Destination” screen will appear. 
• Select “Default (Printer/Screen)” to preview the report prior to printing. Click 

“OK”. 
 

 
NOTES 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



Admin Data 
Entry 

- 68 - 
Phase 1 ADE REV 01/2023 

 

 

 

ALPHABETICAL PROGRAM ROSTER 
 

This report provides an alphabetical listing of all open clients by SubUnit. This report 
can also provide an alphabetical listing of all open or closed clients within a specified 
date range. 
• To access the template from the external view, click on the “File Tab”, select “Menu”, 

then click on “Client Assignments”, “Client Assignments Reports”, then “Client Roster 
Report”. 

 

• Select “Load” on the Client Roster Report window. 
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• Highlight “Alphabetical Program Roster” from the template list and select “Load”. 
 

 
• On Selections 1 tab, enter Unit and SubUnit. 
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• Selections 2 tab is pre-set for open cases on the current date. No selections are 
required unless, a specific date range and/or “All” or “Closed” cases are needed. 
When “All” or “Closed” cases are desired, select the appropriate Radio button. 

 

 
* For a caseload count as of today leave all dates blank. 

or 
* For new cases opened in a specific month, enter the date range for that 
month in the “Assignments with Dates Opened From” fields. 

or 
* For cases closed in a specific month, enter the date range for that month in 
the “Assignments with Date Closed” fields. 

or 
For a total of all previously opened cases and new open cases in a specific 
month enter the date range for that month in the “Assignments which were 
Open (in effect from)” field. 

 
• Select “Print” to print the report. 
• The “Print Destination” screen will 

appear. 
• Select “Default (Printer/Screen)” to 

preview the report prior to printing. 
Click “OK”. 
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CASELOAD ROSTER BY SUBUNIT AND SERVER 
This is a case load report that will list a specific SubUnit’s caseload sorted by server 
with page break between servers. To remove the “page break” go to the 
“Sort/Subtotal/Title” tab and remove the check mark in the “Pagebreak” column after the 
“Assign Server”. The “Pagebreak” can also be removed after the “SubUnit”. 

 
• To access the template from the external view, click on the “File Tab”, select 

“Menu”, then click on “Client Assignments”, “Client Assignments Reports”, then 
“Client Roster Report”. 

 

 
• Select “Load” on the Client Roster Report window. 
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• Highlight “Caseload Roster Report by SubUnit and Server” from the template list 
and select “Load”. 

 

 
• On Selections 1 tab, enter Unit and SubUnit. 
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• Selections 2 tab is pre-set for open cases on the current date. No selections are 
required unless, a specific date range and/or “All” or “Closed” cases are needed. 
When “All” or “Closed” cases are desired, select the appropriate Radio button. 

 

 
* For a caseload count as of today leave all dates blank 

or 
* For new cases opened in a specific month, enter the date range for that 
month in the “Assignments with Dates Opened From” fields. 

or 
* For cases closed in a specific month, enter the date range for that month in 
the “Assignments with Date Closed” fields 

or 
For a total of all previously opened cases and new open cases in a specific 
month enter the date range for that month in the “Assignments which were 
Open (in effect from)” field. 

 

• Select “Print” to print the report. 
• The “Print Destination” screen will 

appear. 
• Select “Default (Printer/Screen)” 

to preview the report prior to 
printing. Click “OK”. 

 
 

Note: Programs usually run this report monthly 
after the previous months data entry has been 
completed. However this report can be run 
anytime. 
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BHS-025 CLIENT CHANGE REQUESTS 
 

• Login to the Optum website with your username and password 
• Click on BHS Provider Resources  MHP Provider Documents  Forms 
• Download the form fills needed 

 
*Please note these forms MUST be typed. 

 
 

BHS-025 FORM A AND B JOB AID 

Form A- to be used to request changes to the following*: 
1. Name (Sort name, Last Name, First, Middle Name) 
2. DOB (date-of-birth) 
3. SSN (social security number) 
4. Sex (Gender) 
5. Medi-Cal Policy Number /Effective Date 

 
Form B- to be used to request two medical record numbers, for the same person, to be 
combined. 

How to Find Core Client Information (CCI): 
 

1. Search for desired client in CCBH. 
2. Once in the client’s chart RIGHT click on clients DOB, a small window will pop up. 
3. Select “Show Core Client Information.” 

 

*Users should NOT make 
changes to Name, DOB, SSN, 
and Sex when creating a 
Demographic Form. 
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4. The CCI will display. 
 

 
How to Complete BHS-025 Forms: 

1. Section #1-Requester Information: Should be completed for BOTH forms. All sections 
should be completed. The Requester is the person completing the form. 

 
2. Section #2-Client Information: 

For Form A “Client Record” column should be completed as data appears in Core Client 
Information (CCI). In “Change Client Record TO” column ONLY fill in the sections that 
need to be changed. 
For Form B “Client Record A” and “Client Record B” columns should both be completed as 
data appears in CCI. 

 
To find Medi-Cal Policy # and effective date click on “Insurance Coverages” tab on bottom 
of page. 

 
Columns should be completed using the CCI (See How to Find CCI instructions above). 
Columns are completed from TOP to BOTTOM. DO NOT USE DEMOGRAPHIC FORM 
OR FACE SHEET. 
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TRAINING TIP SHEET 
 

1. WHEN YOU GO BACK TO YOUR PROGRAM: 
You are learning how to enter assessments in the “SDC Train CCBH” 
environment during this training, which is for practice purposes only. It is 
important to enter all of your assessment information in the “SDC Live CCBH” 
environment when you return to your program. 

 
2. SUPPORT DESK – IMPORTANT!: 

Please do not try to solve issues by “working around” the system. You are to 
enter data as required and you must call the Support Desk for any questions. 

 
The Support Desk contact information is: 

 
Optum Support Desk Contact Information 

800-834-3792 
sdhelpdesk@optum.com 

 
3. FOR ONLINE USER MANUALS AND FORMS: (including forms and form-fill versions of 

assessments for “emergency” situations) go to the Optum website below and follow 
these instructions: 

https://www.optumsandiego.com 
Click "Register" to get an on-line form for your personal login. 
Confirm your email address. 
When you have access, click “Login”. 
Login with your User Name and Password. 
Go to "Secure Documents". 
Select CCBH (formerly Anasazi) Secure Documents 
Click "Forms" or "Manuals". 

4. TO REGISTER FOR ADDITIONAL TRAINING: 

www.regpack.com/reg/optum 
 

5. HIPAA REGULATIONS FOR TRAINING: There is actual client data (names, etc.) in the 
training environment. HIPAA regulations mandate this information be treated 
confidentially. 

6. NON-USE OF CCBH ACCOUNT: Inactive accounts pose a security risk by allowing an 
opportunity for unauthorized access. Therefore, in order to safeguard protected health 
information, inactive accounts will be closely monitored. Users who have not used CCBH 
in 90 days will have their account deactivated. 

mailto:sdhelpdesk@optum.com
http://www.optumsandiego.com/
http://www.optumsandiego.com/
http://www.regpack.com/reg/optum
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Support Desk Contact Information 
sdhelpdesk@optum.com 

1-800-834-3792 
 

Monday through Friday (E-mail) 

Monday through Friday (Telephone) 

 
 

Weekends (Telephone) 
Hours Services 

4:30 am to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

* By definition, a system outage affects multiple users. Examples include when: 
-The system does not respond and appears to be frozen 
-No data can be entered or viewed 

 
Support Desk Suggestions 

 
• Please consult with your program manager and your resource packet prior to 

contacting the Support Desk. 
 

• When calling for a password reset on weekdays between 4:30-6a or 6-11p, or 
calling weekends between 4:30a-11p, you must leave a message. Include your 
name, CCBH staff ID, phone number and the reason for your call. 

 
• You may be given a ticket/tracking number if you call between 6:00a and 6:00p 

Monday through Friday. Remember to keep this number for future reference. 
 

Additional Contacts 
 

Questions Where To Go 
Clinical Documentation Questions Documentation Manual/Your Program Manager 
Duplicate Clients and 
Name/DOB/Gender/SSN Changes 

Complete Form BHS-025 and 
Call Medical Records: 619-692-5700 x 3 

Financial Questions (UMDAP/Insurance) Billing Unit: 619-338-2612 Fax- 858-467-9682 
Online User Manuals and Forms www.optumsandiego.com 
Service Codes CCBH (Anasazi) User Manual/QM Unit 

 

Hours Services 
6:00 am to 6:00 pm All services except password resets or any service involving PHI 

 
Hours Services 

4:30 am to 6:00 am Resetting passwords (24 hour programs) and reporting system outages* 
6:00 am to 6:00 pm All services 
6:00 pm to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

 

mailto:sdhelpdesk@optum.com
http://www.optumsandiego.com/
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